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PLEASE NOTE: This content is only relevant for users that have
had their email migrated into Flank Speed. If you are unsure if
you have been migrated or not, see Step 1 on page 1.

Meet Fathom, our mascot who promotes
our journey to M365 and the adoption of
Navy Cloud services.

Head to the Flank Speed hub (top left icon
in Teams) to ask a question to "Fathom-
Bot", our interactive artificial intelli-
gence robot. FathomBot has over 500
FAQs loaded in its database.

o
‘ Stay connected on Teams @j
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Getting Started in Outlook

Congrats! You have a new @us.navy.mil email address and your old @navy.mil account has successfully
been migrated to Flank Speed. This means you will no longer have access to your @navy.mil inbox, but all
of your emails, calendar invites, contacts, and tasks have been moved to your Flank Speed inbox for you.
In addition, forwarding has been set up to direct any new emails or invites sent to your old address to
your Flank Speed inbox. Any outgoing messages will be sent from your new @us.navy.mil account.

In order to ensure your mailbox has been moved and get your Outlook client set up for Flank Speed,
please follow these steps:

Confirm your @navy.mil inbox moved to your Flank Speed account.

Log in to your Flank Speed account (@us.navy.mil) via https://portal.apps.mil (the Edge browser

with an "InPrivate" window is preferred). If you have not logged in before, please reference the Startup
Guide posted here. If you are unable to access Outlook from the portal, try accessing directly via
https://outlook-dod.office365.us/.

If your email appears at login—congrats, you're migrated! o
You can now use Outlook via your web browser. :

If you get the 500 error at right, your email has not been Semmething wertwiong,

migrated yet. If you can't access Flank Speed Outlook
Web Access (OWA), DO NOT PROCEED.

Configure your installed Outlook client for your new Flank Speed account.

Click on your computer's Windows
icon and go to "Control Panel".
Select "Mail (32-bit)".
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Select "Show Profiles...". B Mail Setup - FLANKSPEED =

E-mail Accounts
JI Setup e-mail accounts and directories. Enail Accoimizy

Data Files

#= Change settings for the files Outlook uses to

Data Files...
1?3 store e-mail messages and documents.

Profiles

; g Setup multiple profiles of e-mail accounts and Show Profiles...

data files. Typically, you only need one.
‘.:';'3
Close A



https://portal.apps.mil
https://portal.secnav.navy.mil/orgs/OPNAV/N2N6/DDCION/FlankSpeed/SitePages/Home.aspx
https://portal.secnav.navy.mil/orgs/OPNAV/N2N6/DDCION/FlankSpeed/SitePages/Home.aspx
https://outlook-dod.office365.us/

Select "Add..." to create a new profile.
Type in "FLANKSPEED" for the profile
name and select "OK".

@t

General

L_:‘B The following profiles are set up on this computer:

"J New Profile e
_) Create New Profile oK
Profile Name: Cancel
FLANKSPEED|

Add.. | Remove || Properties | copy...

When starting Microsoft Outlook, use this profile:

':) Prompt for a profile to be used

(@ Always use this profile

Your old email address will populate
in the email address box.

Delete it and type in your new
<username>@us.navy.mil email
address. Click "Next".

]

Auto Account Setup
Outiook can automatically configure many emad accounts.

(®) E-mail Account

Your Hame:

Example: Ellen Adams

E-mail Address: buzz.alightyear. mil@ us. navy.mil
Example: ellenScontoso.com

Password:

Retype Password:

Type the pastword your Internat service provider has given you.

() Manual setup or additional server types

Next =

Cancel

You should see a screen going through
a series of checks, this will take a few
minutes. After all three steps have green
check marks, select "Finish".

The "Mail" window should still be open.
Ensure your Flank Speed account is se-
lected under "Always use this profile"
and click "Apply" first and then "OK".

NNPI USERS PLEASE NOTE:

Because NNPI users have two mailboxes,
please select "Prompt for a profile to
be used" so you can access your NNPI
mailbox when desired.

B} Add Account

Congratulations!

Configuring

Outlook is completing the setup for your account. This might take several minutes.
+  Establishing network connection
+  Searching for andrew.m.tash.cv@us.navy. mil settings
+  Logging onto the mail server

Congratulations! Your email account was successfully configured and is ready to use,

[Jchange account settings

Finish

Add another account...

Cancel

D Mail ®

General

'_‘\D The following profiles are set up on this computer:
-

Flank Speed

Properties Copy...
When starting Microsoft Outlook, use this profile: F
() Prompt for a profile to be used
(®) Always use this profile
Flank Speed w
oK Cancel Apply




Open your Outlook client. Your email should now start synchronizing (meaning, you will start
to see old emails and invites show up in your Flank Speed inbox). Depending on the size of your
inbox, this could take an hour or more.

Calendar invites will likely be the first thing to appear. If nothing appears, try going to "Send/Receive" and
click "Update Folder".

During synchronization, utilize Outlook Web Access via a browser window (see Step 1) to access
and use your email.

Once you are up and running in Flank Speed Outlook, please reopen Control Panel and repeat
Step 2 on page 1 but instead of selecting "Add..." to create a new profile, select "Remove" and
remove your old @navy.mil account.

PLEASE NOTE: If you used PSTs with your @navy.mil account you will need to remap them
to your Flank Speed Outlook profile. Guidance can be found here on the Microsoft website:
"Open and close Outlook Data Files (.pst)."

Users with shared calendars will need to remove those delegations in support of the mail
migration. Re-establishing shared calendars must wait until users are both mail migrated.

=
TROUBLESHOOTING: If you see one of these two error
messages, please follow these steps to remedy:

Something went wrong

1. Verify that you have been migrated (Step 1 on page 1).
If you have, continue below.

2. Attempt to sign into Flank Speed Outlook Web Ac- ———
cess (OWA) using a private browser in Edge (click the
three dots in the top right of Edge and select "New
InPrivate Window"). If you can connect in private mode,
your non-private browser is caching old sign-in informa-
tion and the following steps will clear it.

3. Remove any non-Flank Speed Outlook profiles
(follow Step 2 on page 1, but select "Remove"
instead of "Add...").

4, Once your old profile(s) are removed, repeat Step 2 on
page 1 to add your Flank Speed profile.

5. If this does not resolve the issue, call your Service Desk to confirm you have MAPI enabled.



https://support.microsoft.com/en-us/office/open-and-close-outlook-data-files-pst-381b776d-7511-45a0-953a-0935c79d24f2
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Configuring Outlook

First, in your Outlook client, click "File" on the top menu.

Setup Email Security

Select "Options".

Automatic Replies (Out of Office)

Use auts hers that you are out of office, an vacafion, ot
Automatic ot available to respond to e-mail meszages

Dutlock Diptions T =

Select “Trust Center”, then
“Trust Center Settings”.

W) Help keep your dacuments safe and yaur computer secure and healthy,

Security & more

Micrasaft Outlook Trisst Center

Trust Center Setings...

Trust Center

Trust Center

Select “Email Security”.

Trusted Publishers ;
Encrypted e-mail

Check "Add digital signature
to outgoing messages" and
then click "Settings".

Type in a security settings
name (can be anything, ex.
"ActiveClientCerts").

Place a check markin BOTH
default security settings.

Privacy Options
Email Security
Attachment Handling
Automatic Download
Macro Settings

Programmatic Access

9‘3 Encrypt contents and attachments for outgoing messages
T
“dd digital signature to outgoing messages

Request S/MIME receipt for all S/MIME signed messages

Settings...

Digital IDs (Certificates)

= ] Digital IDs or Certificates are documents that allow you to prove your identity in ele

Publish to GAL... | | Import/Export... | | Get a Digital ID...
Change Security Settings *
Security Setting Preferences
Security Settings Mame:
ActiveClient Certs v

Cryptography Format: | S/MIME
v Default Security Setting for this cryptographic message format
| Default Security Setting for all cryptographic messages
Security Labels... MNew Delete
Certificates and Algorithms
Signing Certificate: Signature - BUROW.THOMAS.JAM Choose..
Hash Algorithm:
Encryption Certificate: |Encryption - BUROW.THOMAS.JAI

Encryption Algorithm: | AES (256-bit) ~

SHA1 ~

Send these certificates with signed messages

OK Cancel

R




Change Security Settings Y Windows Security x

Select a Certificate

Security Setting Preferences

Security Settings Name: Signature -
| AdiveCiient Certs v e
Cryptography Format:  S/MIME Valid From: 12/30/2019 to 11/23/2022
[ Default Security Setting for this cryptographic message format Cl|Ck the fl rst "Choose".". Click here to view certificate properties
Drefault Security Setting for all cryptographic messages i

Securty Labels, | | Mew Delete Select the “Signature” (email) e
Certificates and Algorithms certlflcate Cl|ck "Ok"- Issuer: DOD ID CA-50

Valid From: 12/30/2019 to 11/23/2022

Signing Certificate: Signature - BUROW. THOMAS.JAM Choose...

Hash Algorithm: SHA1 ~

Encryption Certificate: |Encryption - BUROW.THOMASJA| || Choose.., |

Encryption Algorithm: | AES (256-bit) w Clle the
oK Cancel
| 5end these certificates with signed messages
€ 9 9 second
OK Cancel "Choose n
e Windows Security X

Select a Certificate

You should only have one
choice, select the “Encryption
certificate. Click "Ok". Isuer: DOD EMAL CA-50

Valid From: 12/30/2019 to 11/23/2022

”» Encryption -

In the "Change Security
Settings" box, click "Ok".

oK Cancel

Re-publish your certificates to the GAL

Trusted Publishers

Encrypted e-mail
Privacy Options

Remaining in the "Email Security" tab, S| R e e

/| Add digital signature to cutgaing messages

click "Publish to GAL..."
o0e o Automatic Download Request S/MIME receipt for all S/MIME signed messages

Default Setting: | ActiveClient Certs | | Settinge...

Programematic Access

l' k n kll h _ Digital IDs (Certificates)
Click "0k on the pop-up. e ————

Bublizh to GAL... M| Import/Expert Get a Digital D,

Read as Plain Text

Read all standard mail in plain text

| Microseft Outloak is about to publish your default security certificates to the Global Address List,

Enter your PIN when requested
then click "Ok".
£ ] I
T
Once done, you will see a status Microsoft Outlook X

message. Click "Ok".

o Your certificates were published successfully,

0K

P s o I
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Global Address List (GAL)

To avoid email delivery errors during Flank Speed transition, send all emails to legacy email
addresses (e.g. @navy.mil). To do that, follow the following steps to get up and running with
the US Navy Global Address List (GAL):

Clear your cache via one of the following two methods.

Method 1 Method 2
Open your Outlook client. Start Outlook using the /CleanAutoCompleteCache switch:
On the "File" tab, select "Options". Select "Start", and then select "Run".
Select the "Mail" tab. Type "Outlook.exe /CleanAutoCompleteCache".

Under "Send Messages", uncheck "Auto-
matic name checking". Then select
"Empty Auto-Complete List". Then "Yes".

Empty Auzo-Complete Lint

Force a GAL sync so that "US Navy" shows up in the Address Book List.

Navigate to the following file using "File Explorer"
c:\Program Files (x86)\Microsoft Office\GlobalDirectory\GALSYNCU.exe

When at the file location, double click the program and let it run.

Close and restart Outlook.




Set your default GAL to ""US Navy".

Open your Outlook client and from the "Home" tab click on "Address Book".

“ Home Send / Receive Folder WView McAfes E-mail Scan

. Ignare W Move to: 7 ) :
[~ iy x ] [T Meeting . . * ¥ { " # =il p- -
- %% Clean Up - » Py A o Team Email v Do L : [} Address Book
New New o Delete  Reply Reply Forward %y pore - - ¥ Move Rule: OneNote Assign Unread/ Categorize Follow
T & M Reply & Delete Create New :
Email ltems - 8 Junk Ail ¢ L eate N 2 ; ;
. S

Policy - LR ] Up~ W Filter Email =
Cluiick Steg . Mo Tags Find

From the pop-up menu, click on "Tools" then "Options".

From the second pop-up menu, click the radio button for "Custom" and select "US Navy". Click the up
arrow to the right of the list until it hits the top of the Custom lists. On the last drop-down menu select
"US Navy" to instruct Outlook to use the US Navy GAL by default. Click "OK".

Addressing x

When sending e-mail, check address lists in this order:

() start with Global Address List
() start with contact folders

@) Custom
~
Offline Global Address List 1
Contacts
BUMED
EDS 3
Office of the Secretary of Defense v

Add... Remove Properties

When opening the address book, show this address list first:
v

QK Cancel

Reboot Outlook for the changes to take place.

P e A &
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Encrypted Emails

How to send S/MIME encrypted emails using Flank Speed email (@us.navy.mil) in Outlook 2016.

NOTE: For now, you must be on an NMCI device using Outlook to use S/MIME email encryption. It is possible
to install a plugin on your personal browser, however this feature is difficult to configure properly and is not
supported by the Flank Speed team. Once enough users are on Flank Speed mail services, other more secure
encryption methods will be deployed which will allow encrypted access from other devices without the use
of a CAC or S/MIME.

Open Outlook. Select "New Email". Click "To".

Under the Address Book header, click on the drop down menu and select "US Navy"
(reference previous page, Step 3). Search for the users you need to send an email to and
add them. Close the address book.

Under the "Options" tab select "Encrypt" and/or "Sign" as appropriate.

Unclassified
H 6 O . Test of Encrypted Email - Message (HTML)

File  Message  Insert JIECTITORMNFormat Text  Review ) Tell me what you want to do

AAI Bcolors~ i 3 £ o | Eapt| Ui Request a Detvery Racoipt e - :2_
==X [AlFonts - e g 3
hemes Alronts

T Save Sent Delay Direct

Page Bcc  From  PermissiofiQ Sign Use Voting Request a Read Receipt
0l Item To - Delivery Replies To
More Optior _

Effocts * Color - . Buttons ~

Punch, Bradiey Christopher ($4200) CIV USN NIWC ATLANTIC SC (USA)

Test of Encrypted Email

This is a test of encrypted and digitally signed email]

Select "OK" if prom pted_ ActivClient - PIN Always Prompt ? X
Hit "Send". ActivCiient:

You are sbout to digitally sign a file or message.
Please confirm that you want to use your smart card for this operation.

oK Cancel




TROUBLESHOOTING: You may see this error Invalid Certficate X
when trying to sign or encrypt an email for the Microsoft Outieok cannot sign or sgervpt this message because there are no certificates which can be used to
send from the e-mail address ' Bus.navy.mil'. Either get a new digital ID to use with this

ﬁ rst ti me from the C“ent after m igration . account, or use the Accounts button to send the message using an account that you have certificates for.
Follow these steps to resolve:

1. Goto File > Options > Trust Center > Trust g Secury St
Center Settings > Email Security.

2. Navigate to Encrypted email > Default Setting > Settings.
Type in a name for security settings (e.g. “My Policy”).

3. Under "Certificates and Algorithms", click "Choose" to the right of Signing Certificate.
Ensure the Signature certificate is selected. Click "OK".

Do the same for "Encryption Certificate". Click "OK".
Check "Send these certificates with signed messages". Click "OK".




